
What is infrared?

Infrared is light that is beyond red in the spectrum. While it’s not visible to the human eye, infrared transmitters 
and receivers can send and receive infrared signals.



What is Infrared Monitor?

You use Infrared Monitor to keep track of your computer’s infrared activity. With Infrared Monitor, you can: 
Find out what infrared devices are within range of your computer.
Find out if your computer is currently communicating with an infrared device, and if it is, how well it is 

communicating.
Control how Infrared Monitor reports status on the infrared activity it detects.
Decide what type of infrared activity to allow.



To find an infrared device
To communicate with another infrared device, you need to make sure infrared communication is turned on 

and that the devices are positioned so that they can send infrared light to each other. To send light to each other, 
they need to be roughly facing each other and no further apart than about three to nine feet (one to three meters).

Tip
For information about determining whether your device is in range, see Related Topics below.

{button ,AL("a_infrared_in_range;a_no_device_in_range;a_disable_ir;a_stop_searching")} Related Topics



To determine whether a device is in range

1 Click here  to open Infrared Monitor.
2 Click the Options tab.
3 Make sure the option to search for devices is checked, and that the time interval to search is a low number 

(such as three seconds).
If the option to search for devices is not available, click the option to enable infrared communication.

4 Click Apply.
5 Click the Status tab.
6 Reposition the devices until Infrared Monitor confirms that the range is adequate.

{button ,AL("a_no_device_in_range;")} Related Topic



To print to an infrared printer
1 Make sure your infrared printer is in range. 

If you aren’t sure how to do this, see Related Topics below.
2 Make sure the printer is assigned to the infrared printer port. 

For more information, see Related Topics below.
3 Print as you usually do.

{button ,AL("a_cant_print;a_install_another_device;a_printer_assign_infrared")} Related Topics



To assign a printer to an infrared port

1 Click the Start button, point to Settings, and then click Printers.
2 Click the icon for the printer you want to use.
3 On the File menu, click Properties.
4 Click the Details tab.
5 Make sure the port listed under Print To The Following Port is the infrared port.

{button ,AL("a_cant_print")} Related Topic



To install software for an infrared device

1 Using your right mouse button, click the Infrared icon on the taskbar. Make sure Enable Plug And Play is 
checked.

2 Verify that the new device is in range. For more information, see Related Topics below.

Note
If you are not sure whether the device you are installing is Plug and Play aware, check the user’s guide for 

the device. If it is not Plug and Play aware, install it by double-clicking the Add New Hardware icon in Control Panel.

{button ,AL("a_no_device_in_range;a_stop_installing;a_stop_searching;a_enable_taskbar_icon")} Related Topics



To set up Direct Cable Connection over infrared

1 Click the Start button, point to Programs, point to Accessories, and then click Direct Cable Connection. 
2 Follow the instructions on your screen.
3 When you are asked to select the port you want to use, click the infrared communications port, and then click 

Next.

Note
When you are using Direct Cable Connection over infrared, infrared takes the place of the cable. You do not

need to use a serial or parallel cable.

{button ,KL("direct cable connection")} Related Topics



To turn on infrared communication
1 Using your right mouse button, click the Infrared icon on the taskbar.
2 Make sure Enable Infrared Communication is checked.

Tips
To turn off infrared communication, make sure this item is not checked.
If the taskbar icon is not visible, see Related Topic below.
When infrared communication is turned off, the Search For And Provide Status For Devices In Range and 

Enable Software Installation For Plug And Play Devices In Range options are also turned off.

{button ,AL("a_enable_taskbar_icon")} Related Topic



To turn on searching and status for infrared devices
1 Using your right mouse button, click the Infrared icon on the taskbar.
2 Make sure Search For Devices In Range is checked.

Notes
This option is available only if infrared is enabled.
To turn off searching and status, make sure this item is not checked. If you turn off searching and status, 

you will not be able to see whether infrared devices are in range.
If the taskbar icon is not visible, see Related Topics below.

{button ,AL("a_enable_taskbar_icon;a_disable_ir")} Related Topics



To turn on support for installing Plug and Play devices
1 Using your right mouse button, click the Infrared icon on the taskbar.
2 Make sure Enable Plug And Play is checked.

Notes
To turn off support for Plug and Play device installation, make sure this item is not checked.
This option is available only if infrared and searching are enabled.
If the taskbar icon is not visible, see Related Topics below.

{button ,AL("a_enable_taskbar_icon;a_install_another_device;a_disable_ir;a_stop_searching")} Related Topics



To be notified when infrared communication is interrupted

1 Click the Infrared icon on the taskbar.
2 Click the Preferences tab.
3 Click Play Sounds For Devices In Range And Interrupted Communication.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.

{button ,AL("a_comm_interrupted")} Related Topic



To turn on Infrared Monitor sounds

1 Click here  to display Infrared Monitor.
2 Click the Preferences tab.
3 Make sure the option to play sounds is checked.

Tips
To turn off Infrared Monitor sounds, make sure this box is not checked.
If your computer has a sound card, you can double-click the Sounds icon in Control Panel to change which 

sounds are assigned to Infrared Monitor events.

{button ,AL("a_tnt_sounds")} Related Topic



To display the Infrared icon on the taskbar

1 Click here  to display Infrared Monitor.
2 Click the Preferences tab.
3 Make sure Display The Infrared Icon In The Taskbar is checked.

Tips
To hide the Infrared taskbar icon, make sure this box is not checked.
If you hide the taskbar icon, you must open Infrared Monitor by double-clicking the Infrared icon in Control 

Panel.



To specify which sounds to use for Infrared Monitor events

1 Click here  to display Sounds properties.
2 In the Events list, click the Infrared Monitor event you want to change.
3 In the Name list, click the sound you want Windows to play whenever the selected event occurs.

Tips
To play special sounds, you must have a sound card installed.
To test a sound, click it, and then click the 

 button.
You can save your sound settings by clicking Save As and then naming the sound scheme you created. 

That name will appear in the Schemes list, so that you can easily restore these settings.

{button ,AL("a_adjust_irmon_sounds")} Related Topic



If Infrared Monitor doesn’t see a device in range

Make sure that:
Infrared is turned on.
Searching is turned on.
The search interval is not too high.
The device is not too far away.
The device is IrDA compliant.
The device is turned on.
The infrared on the device is turned on.
There is nothing blocking the infrared activity.
There is no dirt or grease on the infrared windows.
Direct sunlight is not shining on the infrared receiver.
There are no non-IrDA devices attempting to communicate.

{button ,AL("a_disable_ir;a_stop_searching")} Related Topics



If an infrared device frequently goes out of range

If communication with a device fails intermittently, try the following steps:
Move the infrared devices closer together.
Check for partial obstructions of infrared activity.
Make sure the devices are not moving or vibrating.
Clean the infrared windows.
Shade the devices, or turn off bright lights.
Recharge the batteries for the device, or check its power supply.



If you can’t print to an infrared printer

Make sure that:
The printer is turned on.
The printer is in range.
The printer is assigned to the infrared printer port.
Infrared communication is turned on.

{button ,AL("a_no_device_in_range;a_print_to_ir;a_disable_ir;a_stop_searching;a_printer_assign_infrared")} 
Related Topics



If communication efficiency is not good

Try the following steps:
Move the infrared devices closer together.
Check for partial obstructions of infrared activity.
Make sure the devices are not moving or vibrating.
Clean the infrared windows.
Shade the devices, or turn off bright lights.



If communication is interrupted

If infrared communication is interrupted, it is usually because something has moved between the infrared 
devices or one device has been moved. Remove the obstruction, or move the device back into range.
If there is no obstruction and the devices are in range, check to see if a non-infrared device is interfering with the
infrared communication.

Note
If communication is restored before the Status properties countdown ends, no data will be lost.

{button ,AL("a_adjust_irmon_open")} Related Topic



The Infrared Developers Association (IrDA) is a group of computer and software manufacturers who have agreed 
on a format for communication among infrared devices. The IrDA standard helps ensure that infrared devices 
from various manufacturers will be able to understand each other.



Infrared is light that is beyond red in the spectrum. While it’s not visible to the human eye, infrared receivers can
detect and respond to infrared signals. Many remote controls use infrared to communicate. 



Infrared Monitor can play sounds when a device comes into range, when a device moves out of range, and when 
communication is interrupted.



Because the light emitted by these infrared devices spreads out in a cone-shaped pattern from the transmitting 
device, the two devices must be placed roughly facing each other. The actual limit will vary but resides within 
approximately a 30-degree cone.



Click Help Topics to return to the list of topics. 



Shows the current status of infrared activity.



Describes the current status of infrared activity. Also may show how often Infrared Monitor looks for devices in 
range and whether the system will automatically install software for new Plug and Play devices as they come 
into range. 
To modify these settings, click the Options tab.



Lists all devices currently in range, and displays an icon that shows the type of device.



Shows how much time remains before Infrared Monitor stops trying to communicate with the current device.



Shows the quality of communication between the computer and the other infrared device. Even if 
communication is poor, no information will be lost, since infrared devices verify that each piece of information 
they send is received correctly by the other device. Each piece of information is resent until it is properly 
received. 



Shows the quality of communication between the computer and the other infrared device. Even if 
communication is poor, no information will be lost, since infrared devices verify that each piece of information 
they send is received correctly by the other device. Each piece of information is resent until it is properly 
received.



Shows information about the device the computer is currently communicating with over infrared.



Shows the type of device the computer is currently communicating with over infrared.



Shows the name of the device the computer is currently communicating with over infrared.



Shows a description of the device the computer is currently communicating with over infrared. 



Specifies whether Infrared Monitor should enable infrared communication. Also specifies the physical port that is 
being used by infrared.



Lists which ports are assigned for use by infrared devices. 
When you use infrared devices, your program may require you to specify a port that the device is connected to. 
Because infrared does not require a physical port, Windows simulates new ports for you to use. 



Specifies whether to search for infrared devices that are in range of your computer. 
If searching is turned on, the Infrared Monitor Status properties and taskbar icon will show whether any infrared 
devices are currently in range. If this option is unavailable, click Enable Infrared Communication to enable it.



Sets the amount of time between searches for infrared devices in range. If this option is unavailable, you can 
enable it by clicking Enable Infrared Communication and Search For And Provide Status For Devices In Range.



Specifies whether to install software automatically for new Plug and Play devices when they come into range. 
Note that devices need to be installed only once, not each time they come into range. If this option is 
unavailable, make sure Enable Infrared Communication is checked.
If you frequently bring your portable computer near another Plug and Play infrared device that you do not want 
to install, you may want to disable this option.



Resets Infrared Monitor Options to the default settings.



Specifies that Infrared Monitor should display a dialog box automatically when infrared communication is 
interrupted. Infrared Monitor will inform you that communication has been interrupted, and then automatically 
close when the interruption is over. If you use the Infrared Monitor dialog box while it’s open, it remains on the 
screen until you close it.



Specifies that Infrared Monitor should use sound to notify you when a device comes into range, when a device 
moves out of range, and when communication is interrupted. If your computer has a sound card, you can double-
click the Sounds icon in Control Panel to change which sounds are assigned to these events.



Hides (or shows) the icon for Infrared Monitor on the taskbar. 
Note    If you hide the taskbar icon and close the Infrared Monitor dialog box, you must open Infrared Monitor by 
double-clicking the Infrared icon in Control Panel.



Resets Infrared Monitor Preferences to the default settings.



Shows information that the computer uses to identify itself to other infrared devices and to network devices (if 
you are connected to a network). Changes made to this information also appear in the Network properties in 
Control Panel.



Shows the name that the computer uses to identify itself to other infrared devices and to network devices (if you
are connected to a network). Changes made to this information also appear in the Network properties in Control 
Panel.



Shows the description that the computer uses to identify itself to other infrared devices and to network devices 
(if you are connected to a network). Changes made to this information also appear in the Network properties in 
Control Panel.



Shows version and copyright information about Infrared Monitor.



Enables you to set a maximum speed for infrared device.
By default, infrared devices communicate at the highest speed possible. However, in some cases, lowering the 
speed of the devices improves communication by eliminating numerous retries.



Select the maximum speed (in kilobytes per second) for infrared device communication.




